ASP Day #1: Intro to ASP.NET web programming
Web applications
A client computer running a web browser sends a request to a web server computer running a web server program.
Microsoft's web server is Internet Information Services, or IIS.
The server computer also can run a database management system such as SQL Server.
How static web pages work
A static web page is a web page that looks the same every time it is viewed.
Static web pages are created using HTML.
The client computer sends a request for a web page and the server locates the page and returns it to the client.
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How dynamic web pages work
A dynamic web page is an HTML document that is created by an application server. The content of the page is created on the fly each time a request is made and the content can vary depending on the information that has been sent by the user.
If a request for a dynamic web page is received, the server looks at the file extension on the web page and uses that to determine which application server to send the request to. When the file extension is .ASPX, the file is passed to ASP.NET for processing.
The ASP.NET server executes the commands in the ASPX file and generates an HTML file that is then returned to the web server, which in turn returns it to the client.
The client can interact with the web page using controls. The controls can cause the web page to be posted back to the web server. This time, the controls will be used to send information back to the server. The web page is again processed by the web server and ASP.NET to create a new web page and the cycle is repeated.
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HTTP State
State refers to all of the values of the properties, variables, etc. of an application.
HTTP is a stateless protocol. That means that it doesn't keep track of state information from one web request to the next. If you stay at a web site and make 50 page requests in a row, the web server treats each one as if it was the first one.
ASP.NET State
ASP.NET provides ways to maintain state between web page requests:
1. It maintains view state to keep track of what is on the form. 
1. Whenever a client starts a new session, it creates a session state object with a session state ID value. When a subsequent page request is made, the session state ID is used to connect the request with its session state data. You can write code to add data to the session state.
1. When an application begins, ASP.NET creates an application state object with data for the entire application. These values are available to all users of the application until the application ends.
1. ASP.NET can keep a profile for each user. Profile information is kept in a database and therefore exists even after a session or application ends. When a user returns to the web site, his personal information can be retrieved from his profile.
Developing ASP applications
We will use Visual Studio to develop our ASP.NET applications. Visual studio comes with its own web server called the ASP.NET Development Server so we can write and test our applications on a single computer without even being connected to the Internet.

Creating a new web application
In Visual Studio, click on File | New | Project. 
In the New Project dialog box, under Templates, choose Visual C#. In the center of the screen, choose ASP.NET Web Application (.NET Framework).
Then browse to the folder you want (I suggest a folder called ASP for all of your ASP projects) and name the project ASP01LoanPayment.
When asked to choose a template, choose Empty and click on OK.
The current application has no pages (although it has plenty of files). We need to add a page. Right-click on the project name (the bold name right under the Solution name). Choose Add | Web Form. Name the web form Default.aspx. Note that you should not have to add the ".aspx" file extension. 
Source View/ ASPX Code
Look at your web page in Source View. This shows you the HTML that is generated when you place controls on the screen. Look at the code. What you see now is ordinary HTML. We will add some non-standard HTML to it. The part that is non-standard HTML is tags beginning with "<asp:". These elements are for the ASP.NET server.
We will create a one-page web application to compute the payment on a loan. It will look like this:
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Remain in Source View. 
Add an <h1> element by entering the code between the div tags: <h1>Loan Payment Calculator</h1>
From the View menu, click on Toolbox. The Toolbox will appear on the left side. Click on the pin in the title bar to pin it to the side of Visual Studio. Open the list of Standard tools. Add the following controls by dragging them inside of the <div> that is inside of the <form>. Three pairs of labels and text boxes, one pair per line. Set the following properties:
1. For "Label1" set the Text property to Loan Amount:
1. For "TextBox1" set the ID property to txtLoanAmount
1. For "Label2" set the Text property to Interest Rate:
1. For "TextBox2" set the ID property to txtInterestRate
1. For "Label3" set the Text property to Years:
1. For "TextBox3" set the ID property to txtYears.
Next, add a label followed by a drop-down list on the same line.
1. For "Label4" set the Text property to Payments Per Year:
1. For "DropDownList1" set the ID property to ddlPaymentsPerYear
Next, add two labels on the same line. 
1. For the left label (Label5) set the Text property to Payment:
1. For the right label (Label6) , change its ID property to lblPayment
1. For the right label, change its Text property to $0.00
Next, move down a row and add a button. 
1. Set its ID property to: btnComputePayment
1. Also set the Text property of the button to Compute Payment.
Control Prefixes
Use the following prefixes for your controls:
	Control
	Prefix

	Button
	btn or cmd

	Checkbox
	chk

	Drop-down list
	ddl

	Image
	img

	Label
	lbl

	List
	lst

	Panel
	pnl

	Radio Button
	opt or rad

	Textbox
	txt


Layout
The default "layout" for forms is flow layout. With flow layout, controls and text appear one after another. This is the default layout. Note that if we don't do anything, all of our controls will appear on one line:
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Inserting line breaks
You can separate the items on the page using either paragraphs <p>  and </p> or breaks: <br>. Breaks will not add white space (and your web page will look crowded:
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Paragraphs will leave some white space between the lines:
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Inserting spaces
Note that you cannot space items by inserting spaces because HTML collapses white space into a single space.
Tables
To get more control over the layout of the page content, use tables. Switch to Design View (click on the Design tab at the bottom left) to make the Table menu appear (not the ASP Table control, but the HTML Table control). Insert a table into your web page that has 2 columns and 6 rows. To insert a table, choose "Table" | "Insert Table". Cut/paste or drag the components to the table cells. Your document will look like this when done (the table borders should be faintly visible below). Note that you may have to clean up (delete) some empty lines above the table. 
NOTE: When you are in Design view and press the space bar, you will get non-breaking spaces.
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Code Behind Files
The C# code that you run is stored in a file with the .cs (for "C-Sharp") extension. Since our web page file is called Default.aspx, its "code behind" file is Default.aspx.cs. This is where we write our event handlers.
The Visual Studio environment
There are three views:
1. Design
1. Split
1. Source
You will probably prefer to use Design view most of the time.
Examine the Source view. The first set of tags defines a page directive that provides several attributes:
1. The programming language used (C#).
1. The value of the Autoeventwireup variable (more later).
1. The name of the code file (code-behind) for the page. The code file for a page is the same as the page name, but with the ".cs" (for C#) file extension added on.
1. The name of the file that this file inherits from.
"Run" the file (view it in your web browser by clicking on the green arrow at the top).
If you are told that "The page cannot be run in debug mode because debugging is not enabled in the Web.config file. What would you like to do?", choose Modify the Web.config file to enable debugging, and click on the OK button.
In your browser, right-click on the web page, click on View Source, and examine the HTML. It looks completely different from what we saw in our code window. This is because the web server handed off your aspx page to the ASP.NET application handler and it has converted your document to ordinary HTML, returned the ordinary HTML to the web server, and the web server has returned the file to your web browser.
Return to Visual Studio and look at the code.
CSS
If the Properties window is not visible on the right side of your Visual Studio window, click on View | Properties Window. To dock it on the right, click on the down-arrow in the title bar and choose Dock.
In Design view, click on one of your text boxes and examine its property list.
Note that each element (control) has a CssClass property. For the three text boxes, set the CssClass property to input. Note that you can do this in one step if you select all three text boxes first.
In the Solution Explorer, right-click on the project (the project name is in bold and is probably the second line in the Solution Explorer window; don't click on the Solution, which is probably the first line in the Solution Explorer window) and choose Add | New item | Style sheet. Name your file style.css.
Note that we must put a link to the file into our HTML file (in the Head tag):
<link rel="stylesheet" href="style.css"/> 
Add some styling for the input class:
.input
{
    background-color:#ffff8c;
    border:red solid 1px;
    width:10em;
    height:1.5em;
}
NOTE: Be sure to save your CSS file before previewing your web page or your changes will not take effect!
The dropdown list
Set the properties for the drop-down list. We will allow payments once a year, twice a year, quarterly, or monthly (1, 2, 4, 12). In Design View, click on the small right-pointing arrow (>) on the top right part of the drop-down list. Click on Edit items. Click on Add. Set the Text property to 1. When you tab out of the box, the value property will also change to 1 automatically. Add three more items to the drop-down list: 2, 4, and 12. After entering the 12, do not click on Add again. Click on OK.
Run your program. If you get an error message like this (where the control listed could be any control on your computer):
ASP.default_aspx' does not contain a definition for 'ddlPaymentsPerYear_SelectedIndexChanged' …
It means that you probably accidentally double-clicked on the named control. You can delete the error message by going to the source code for the given control and deleting the onselectedindexchanged property (or whatever property was mentioned by the compiler).
The label
Set the CSS class of the label lblPayment to output. Then return to the Style.css file and add the following for the output class:
.output
{
    background-color:#ccc;
    border-style:solid;
    border-width:1px;
    color:Blue;
    width:10em;
    height:1.5em;
    text-align:center;
}
Note: If this does not set the width and height, set the width and height properties in the Properties window (they are not under the Appearance heading, but under the Layout heading) for lblPayment.
Writing C# code
In ASP.NET, we use C# code to handle events. The only event we are concerned about in this application is the click event for the button. In Design view, double-click on the button. 
The following should appear in your cs file:
    protected void btnComputePayment_Click(object sender, EventArgs e)
    {

    }
Return to the Default.aspx page. Switch to the Source view for the page. Note that the code for the button has been changed to this:
<asp:Button ID="btnComputePayment" runat="server" Text="Compute Payment" onclick="btnComputePayment_Click" />
The name of the onclick event handler has been set to btnComputePayment_Click. Switch back to the cs file. We need to write the code for the event handler. The event handler must do the following:
1. Get the loan amount.
1. Get the annual interest rate. Divide the number entered by 100.
1. Get the number of years.
1. Get the number of payments per year.
1. Compute the interest rate per period (divide interest rate by payments per year).
1. Compute the number of payments (multiply years by payments per year).
1. Compute the payment amount. Look up the formula for computing a loan payment online.
1. Display the payment amount properly formatted in the output. Use ToString("C2")
Return to the cs file and write code for the button click event handler.
Things to keep in mind: 
1. The "code behind" file is ordinary C#. Everything you know about C# applies to the code you write.
2. You will have to look up the formula for computing the payment on a loan. 
3. Text boxes have a Text property that holds the value entered by the user.
4. The data type of the Text property is string.
5. Strings must be converted into numbers before computation can be done on them by using one of the Convert methods.
6. Numbers must be converted into strings before they can be displayed in a Text field.
7. Drop-down lists have a property for the value of the selected item, and it is also a string. Look up how to retrieve a value from a drop-down list.
8. Use the Decimal data type for non-integer values because we are using currency.
9. Use this sample data: loan amount is 50000, interest rate is 12, years is 30, periods per year is 12. The payment you should get for this is 514.31 (rounded to the nearest penny).
The Clear button
When the user clicks on the Clear button, clear the three input text boxes (put the empty string in them) and put the value "$0.00" in the payment label.

C# code:
    protected void btnComputePayment_Click(object sender, EventArgs e)
    {
        decimal loanAmount = Convert.ToDecimal(txtLoanAmount.Text);
        decimal annualInterestRate = Convert.ToDecimal(txtInterestRate.Text) / 100;                    
        int noOfYears = Convert.ToInt32(txtYears.Text);
        int noOfpaymentsPerYear = Convert.ToInt32(ddlPaymentsPerYear.Text);
        decimal interestRatePerPeriod =  annualInterestRate /  noOfpaymentsPerYear;
        int computeNoofPayment =  noOfpaymentsPerYear * noOfYears;
         decimal computePaymentAmount =
            loanAmount * interestRatePerPeriod * ((int)(1 + interestRatePerPeriod) ^ computeNoofPayment) / (((int)(1 + interestRatePerPeriod) ^ computeNoofPayment) - 1);

        lblPayment.Text = computePaymentAmount.ToString("C2");         
      }

    protected void btnClear_Click(object sender, EventArgs e)
    {
           txtInterestRate.Text = "";
            txtYears.Text = "";
           txtLoanAmount.Text = "";
           lblPayment.Text = "$0.00";
           ddlPaymentsPerYear.SelectedIndex = 0;

    }
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